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Revision | Revision Details Date

s O
Converted to updated HHS template 9/28/23 Greg Currie

V3  Slide 7, I'1, 17 - AGP to WellPoint reference/phone

number change. Also added missing Molina
contact information

* Added slide 12 — Contact information for each
MCO and FFS
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lowa Medicaid Portal Access

> New to IMPA ? Visit \ X/
https://secureapp.dhs.state.ia.us/impa/Default.aspx (o)

> Select ‘Register New Account’ to register for an IMPA
account. If you are a current user you may skip to the next
slide.
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https://secureapp.dhs.state.ia.us/impa/Default.aspx

lowa Medicaid Portal Access

Towa Medicaid (| & ‘ '
Portal Access WL
Welcome to the Iowa Medicaid Portal Application!
User Name:
| \
Password:
5 { J
Login
Reset Account
Click here for the
User Registration Guide
Featured Functionality

> After completing registration or if you are already an IMPA user,

please complete and submit the Member Waiver Eligibility Access
Request form to request access.

» Once access is secured, users will be assigned the role of “Member
Waiver Eligibility” in IMPA.
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https://dhs.iowa.gov/sites/default/files/470-5655.pdf
https://dhs.iowa.gov/sites/default/files/470-5655.pdf

IMPA — Member Waiver Eligibility

v
Login to IMPA by entering User Name and Password '

lowa Medicaid 6
Portal Access Wi 0

Register New Account Documents

Welcome to the Towa Medicaid Portal Application!

User Name:

1
|

Password:

per— ]

Forgot Password?
Forgot User Name?
Click here for the

User Registration Guide

Featured Functionality

s IMPORTANT INFORMATION (Update)
Please note that if you are uploading medical information to IME related to the Level of Care review process, the IME Quality Improvement Organization (QI0) is responsible for the initial determination of the member’s level of care certification for fee-for-service and MCO
members. The IME QIO or the member's MCO is responsible for annual redetermination or when there has been a significant change in the level of care. Please send the medical information to IME or the appropriate MCO
If the member is a MCO member, please send the medical information to the appropriate MCO

+ Member Waiver Eligibility User Manual

» Member Waiver Eligibility Access Request Form
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IMPA — Member Waiver Eligibility

Select “Member Waiver Eligibility” from the ‘Review’ drop down menu "

Iowa Medicaid : ':.W‘ _
s Good Morning o

Portal Access WL

File » i Manage » rmation » Messages Logout

Localhost/Dev Region

Welcome to the Iowa Medicaid Portal Application!

Click here for the
User Registration Guide

Featured Functionality

+ IMPORTANT INFORMATION (Update)
Please note that if you are uploading medical information to IME related to the Level of Care review process, the IME Quality Improvement Organization (QIO) is responsible for the initial determination of the

member’s level of care certification for fee-for-service and MCO members. The IME QIO or the member's MCO is responsible for annual redetermination or when there has been a significant change in the level of

care. Please send the medical information to IME or the appropriate MCO.
If the member is a MCO member, please send the medical information to the appropriate MCO.

+ Member Waiver Eligibility User Manual

+ Member Waiver Eligibility Access Request Form
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IMPA — Member Waiver Eligibility

After selecting “Member Waiver Eligibility”, the following screen will be
returned

Iowa Medicaid
Portal Access
File» Review» Manage » Information» Messages Logout

* ‘Choose Month' Drop down: Thig is uged to choose which month you are valldating elgipdity Tor your members for HCES Walver or Habilitation Programs. All members eligible during that month that match your TIN and NPI combination will B returned in your Search resulls
* When searching ‘MCO’ or ‘Fee for Service’ - Data is updated overnight. so the previous days values will be reflected.

Troubleshooting

*  For Fee for Service, It member can't be found, consider trying the MCO search. If still can't locate, please email IMPA Supportians. state.ja.us

* For Fee for Service, It you feel any of the oala relaled to one of your Mempers 15 Incorrect, please email [OWANSHeIRDesKREANS, S1a10.18.U5

* For MCO search, if member can be found, consider trying the Fee for Service search. If stil can't locate, contact the appropnate MCO for that specific member
@ lowa Total Care at 1-833-404-1061
@ Molina Healthcare of lowa al 1-844-230-1464
© Wellpoint at 1.800-845.0T85

* For MCO search, i you feel any of ihe data related fo one of your members is incomrect, please contact the appropriate MCO for that specific member
o jowa Total Care at 1-833-404-1061
© Moling Healthcars of lowa a1 1-844-236-1464
o Wellpoint at 1-800.-645.9T85

* For addtional information please refer to Member Walver Eligibility User Manual

Search Criteria
= MCO ) Fee For Service
Choose Month: | --- Select --- vt
Tax [D: )
National Provider Identifier: :
Search ||  Clear
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IMPA — Member Waiver Eligibility

| 4 '
>  Within the Search Criteria section of the screen, radio buttons ‘MCQO’ or ‘Fee For Service’ must be selected '
» Month to view must be selected from the ‘Choose Month’ drop down
» Tax ID drop down arrow must be selected. Upon selecting, the TAX ID returned is based on the assignment of the user signed on. o

Search Criteria

@' MCO O Fee For Service

Choose Month: | February-2022 V| *

Tax ID: ole *

Search Clear

» Select the ‘Search’ button

IOWA
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IMPA — Member Waiver Eligibility

» Once the Tax ID is selected, National Provider ldentifiers associated with the TAX ID will be returned

» In this example, there is one NPI associated with the Tax ID

Search Criteria
@ mMco O Fee For Service

Choose Month: [February-2022 ~|*
Tax ID: ‘ v| =
Choose one or more National Provider Identifiers:

National Provider Identifier:
[+ select an

Search I I Clear

—Search Criteria
@®Mco O Fee For Service

Choose Month: | February-2022 v | ™
Tax ID: -
AEREIE I ERERININE choose one or more National Provider Identifiers: H
-

[ select All

O: O 0

| Search ‘ | Clear

> Select the ‘Search’ button

IOWA
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IMPA — Member Waiver Eligibility

If data is available for the selections made, the following is returned: "

— Search Criteria

®mco O Fee For Service o
Choose Month: | February-2022 ~ | ™
Tax ID: [ ~ |

ACECIEIYEEEREININE | Choose one or more National Provider Identifiers: =i
Select All -
1
-
‘ »
Search ‘ | Clear

Export to CSV Export to PDF
Waiver Begin Waiver End

Provider NPT State ID Member Name Member DOB Waiver Date Date CSR Date
Intellectual Disability 04/01/2016 02/01/2022 07/29/2022

B | B [ Intellectual Disability | 02/01/2022 07/29/2022
B | [ ] 1 Intellectual Disability | 04/01/2016 03/25/2022
| | | | [ Intellectual Disability | 03/01/2018 04/16/2022
| ] [ | HE Intellectual Disability | 02/01/2020 05/05/2022
| i | BN Intellectual Disability | 04/01/2016 08/18/2022
| ] | | | Intellectual Disability | 04/01/2016 07/26/2022
| ] ] [ Intellectual Disability | 04/01/2016 07/29/2022
B | | | e Intellectual Disability | 05/01/2019 01/13/2023
| | ] ] Intellectual Disability | 04/01/2016 02/04/2022
B ] | | e Intellectual Disability | 12/01/2021 08/30/2022
| ] B ] Intellectual Disability | 09/30/2021 10/27/2022
NS Tntellectial Nicahilitv na/18/202n n7/23/7027

IOWA
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IMPA — Member Waiver Eligibility

v
> If there is more data than can be displayed on one page, pagination is available at the bottom left corner of the screen to ‘
advance to additional pages (or jump to specific pages)

> Data in each of the columns returned, can be sorted ascending or descending, by pointing the cursor to the column o
heading and selecting enter.

Search Criteria

- Mmco Fee For Service
Choose Month: [March-2024 ~ "
Tax 10: [ -
Naticnal Provider Identifiers [ Y
Search _Clear_ |

Export to CSV Export to PDF

o —— S oehemee mceon--= o Elcery 12/18/2020 ) 05/18/2024

Eicerly 03/01/2018 04/15/2024
Elzerly 02/06/2020 10/11/2024
Elcery 02/18/2023 05/18/202%
Elcerly 05/01/2017 08/25/2025
Eiderly

_Elderly
Eicerly
Elderly
Elcerly

| Elcerly 03/28/2017

|| Elderly

| Elderly

| Elderiy
| Elderly

05/18/ g |
O7/17/2024
04/23/2024

Health Disabilizy

Eldecly __04/03/2016 | 02/15/2025
Elderly 01/17/2017 07/16/2024

R Elderly 07/12/2023 _ 11/27/2025 |
I Elcerly ©02/01/2016 01/10/2025
N | Elderly 06/15/2016 037/09/2024
| Elcerdy 12/13/20232 12/05/2024
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IMPA — Member Waiver Eligibility

» Contact information is provided at the bottom of each page.
>  When the MCO radio button is selected, this contact information is displayed:

L Elderly 04/01/2016 07/17/2024
[ | Heath Disabilty | 11/01/2019 0423/2024
‘ | Elderly ~04/01/2016 02/15/2025
, [ Elderly 01/17/2017 07/16/2024
2 - Elderly 07/12/2023 11/27/2024
[ [ Elderly 04/01/2016 01/10/2025
[ ; Elderly 06/13/2016 03/09/2024
1 1 Elderly 12/13/2023 12/05/2024

& by lowa Total Care

p'ease conta

2ed by WellPoint, olease contact Froy
zec by Molina HealthCare of Towa, cleas

| o129 |

042572024

12343678010,

ol [T2naaens |

“OUEae 8y QD) WK 13 M 0 4o0r e 2y Tows Medicaid Entarprive. Sadie conact thes Frai G

¥ Secons ot IMPAsupport e stateia.un & 508 1 D Maised dris 2 2569608
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IMPA — Member Waiver Eligibility

Data returned can be exported by selecting the “Export to csv” link

—Search Criteria

@® Mco O Fee For Service

Choose Month: | February-2022 ~ |
Tax ID: ~ |

National Provider Identifier:

Choose one or more National Provider Identifiers:

Select All
1

Search | | Clear

Provider NPT State ID Member Name Member DOB

Export to CSV Export to PDF

Waiver Begin

Date

Waiver End

Date

CSR Date

m———— Tntallartiial Nicahilitv

Intellectual Disability 04/01/2016 02/01/2022 07/29/2022
Intellectual Disability 02/01/2022 07/29/2022
Intellectual Disability 04/01/2016 03/25/2022
Intellectual Disability 03/01/2018 04/16/2022
Intellectual Disability 02/01/2020 05/05/2022
Intellectual Disability 04/01/2016 08/18/2022
Intellectual Disability 04/01/2016 07/26/2022
Intellectual Disability 04/01/2016 07/29/2022
Intellectual Disability 05/01/2019 01/13/2023
Intellectual Disability 04/01/2016 02/04/2022
Intellectual Disability 12/01/2021 08/30/2022
Intellectual Disability 09/30/2021 10/27/2022

na/1R/702n0 n7/32/7077
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IMPA — Member Waiver Eligibility

The selections from the Search Criteria along with the results of the search

are displayed in the spreadsheet O
1 | Report Run Date : 4/14/2022 9:43:54 AM O
2 | Month-Year : February-2022
3 |TaxID :

4 | NPI(s) :

5_

6 Provider NPI StateID Member Name Member DOB Waiver Waiver Begin Date Waiver End Date CSR Date
7| ( | Elderly 5/28/2019 5/7/2022
8 | ] | Elderly 4/7/2011 2/16/2023
9 | Health Disahility 5/1/2020 11/19/2022
10 | Elderly 6/15/2017 5/10/2022
11 i Health Disability 7/19/2002 1/26/2023
12 i Health Disability 2/25/2004 9/20/2022
13 Health Disability 5/17/2006 11/8/2022
14 ] Health Disability 1/1/2018 8/12/2022
15 Health Disability 6/1/2015 3/19/2022
16 Elderly 1/29/2020 1/21/2023
17
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IMPA — Member Waiver Eligibility

v
Data returned can be exported into a PDF by selecting the “Export to PDF” ‘ '
link o o

@ Mco O Fee For Service

Choose Month: | February-2022 ~ |~
Tax ID: ~ |

National Provider Identifier:

Choose one or more National Provider Identifiers:

Select All
1

Search | ‘ Clear

Export to CSV Export to PDF

Waiver Begin Waiver End

Provider NPT State ID ber Name Member DOB Date te CSR Date
Intellectual Disability 04/01/2016 02/01/2022 07/29/2022

| | B 2N Intellectual Disability 02/01/2022 07/29/2022
| | | aE Intellectual Disability | 04/01/2016 03/25/2022
| a | N Intellectual Disability 03/01/2018 04/16/2022
| | | 1 Intellectual Disability 02/01/2020 05/05/2022
| | ] ] Intellectual Disability 04/01/2016 08/18/2022
| | ] HE Intellectual Disability 04/01/2016 07/26/2022
| | ] ] Intellectual Disability 04/01/2016 07/29/2022
| | ] HE Intellectual Disability 05/01/2019 01/13/2023
| i ] ] Intellectual Disability 04/01/2016 02/04/2022
| a u L Intellectual Disability 12/01/2021 08/30/2022
B | | | Intellectual Disability 09/30/2021 10/27/2022
W Tntallartial Nicahility na/Mi/20720 nN7i22/2027%
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IMPA — Member Waiver Eligibility

. o . \ X/
The selections from the Search Criteria along with the results of the search
are displayed in the PDF 0

Fee For Service - Member Waiver Eligibility Member List

Report Run Date: 4/14/2022 9:55:40 AM
Total# of records: 10
Month-Year: February-2022

TaxID:
NPI(s):
Provider |State ID Member Name Member Waiver Waiver Waiver CSR Date
NPI DOB Begin Date |End Date
. i 1. 3 T | Elderly 05/28/2019 05/07/2022
i | Elderly 04/07/2011 02/16/2023
| _| Health Disability 05/01/2020 11/19/2022
i _| Elderly 06/15/2017 05/10/2022
i _| Health Disability 07/19/2002 01/26/2023
| | Health Disability 02/25/2004 09/20/2022
| _ Health Disability 05/17/2006 11/08/2022
| _| Health Disability 01/01/2018 08/12/2022
| 1 _| Health Disability 06/01/2015 03/19/2022
e IO O - - S— i ruios | Elderly 01/29/2020 01/21/2023

IOWA

HHS p



IMPA — Member Waiver Eligibility

User can logout by selecting “Logout” from menu bar

Iowa Medicaid
Portal Access
Review» Manage» Information» Messages Logout

“*IMPORTANT INFORMATION ABOUT THIS APPLICATION"""

* ‘Choose Month' Drop down: This i§ used to choose which month you ane validating algibility for your members for HCBS Walver or Habilitation Programs. All membars eligible during that month that match your TIN and NPI combination will bé returned in your saarch resulls
* When searching 'MCO' or "Fee for Service' - Data is updated overnight, so the previous days values will be reflected

Troubleshooting

* For Fee for Service, It member can't b found, considar trying the MCO search. If still can't locate, please email IMPA Support@adhs state.a.us

* For Fee for Service, It you feel any of the data related to one of your members Is incorrect, please email [oWANSHelpDesk@dhs. state.la.us

® For MCO search, if member canl be found, consider trying the Fee for Service search. If still can't locate, contact the appropnate MCO for that specific membaer
@ lowa Total Care al 1-833.404-1061
o Molina Healthcare of lowa @l 1-844-236.1464
e Wellpoint at 1.800-645.9785

For MCO search, if you feel any of the data related 1o one of your members is incorrect, please contact the appropriate MCO for thal specific member
o Jowa Total Care at 1-833-404-1061
o Molina Healthcare of lowa at 1-B44-236-1464
o Wellpoint at 1-800-645-0785

For agdtonal information please refer o Member Walver ENgIDUINY User Manual

Search Criteria
I MCO U Fee For Service
Choose Month: | --- Select --- vt
Tax [D:
National Provider Identifier: '
Search ||  Clear

IOWA
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IMPA — Member Waiver Eligibility <TIP>

> To hide the instructions section, the user can select the ‘Minimize’ option in the
upper right corner of the screen

Iowa Medicaid ;-'! 2 -
Portal Access N

File» Review» Manage» Information» Messages Logout

“*IMPORTANT INFORMATION ABOUT THIS APPLICATION™™

* 'Choose Month' Drop down: This is used to choose which month you are validating eligibility for your members fer HCBS Waiver or Habilitation Programs. All members eligible during that month that match your TIN and NP combination will be returned in your search
results.

* When searching 'MCOQ' or 'Fee for Service' - Data is updated overnight, so the previous days values will be reflected.

> To display the instructions section, when previously minimized, the user can
select the ‘Restore’ option in the upper right corner of the screen

Iowa Medicaid
Portal Access

Good Afternoon |

e
S

’*Search Criteria ‘

File» Review)» Manage» Information» Messages Logout

IOWA

HHS
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